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SPECIAL NOTE 

 

Due to the continuous evolution of the CDEGS software, you may find that some of the 

screens obtained using the present version of the CDEGS package are slightly 

different from those appearing in this manual. Furthermore, small differences in the 

reported and plotted numerical values may exist due to continuous enhancements of 

the computation algorithms. 
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CHAPTER 1 

INTRODUCTION 

1.1 OBJECTIVE 

The objective of this study is to obtain the electromagnetic fields under a 3-phase transmission line 

and the induced voltages and currents on a fence under the transmission line. The purpose of this 

tutorial is twofold: 

 

Figure 1.1 525 kV Transmission Line and Fence 

1. Give an account of the engineering considerations involved in the modelling of a portion of 

a transmission line. 

2. Familiarize the reader with the use of SES software as applied to the solution of this 

problem. 

The engineering program HIFREQ is used for this study. This example also illustrates the use of 

some of SES input and output processors. 

Please note that you may press the F1 key at any time 

to display context-sensitive help pertinent to the topic 

to which you have given focus with your mouse. You 

may also access the complete help file by selecting 

Contents from the Help menu of the main CDEGS 

interface. 

 

 

 

 

 

 

Fence

525 kV transmission line
430 A
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1.2 ORGANIZATION OF THE MANUAL 

There are 4 main sections to this tutorial: 

1. Description of the problem being modelled (Chapter 2) 

2. How to prepare the HIFREQ input file (Chapter 3) 

3. How to submit the HIFREQ run (Chapter 4) 

4. How to extract and display the results from the HIFREQ output files (Chapter 5) 

Chapter 2 focuses on the engineering aspects of the problem. The remainder of the tutorial gives 

detailed, step-by-step instructions on how to use the software to model the situation. It also includes 

some engineering hints. 

1.3 SOFTWARE NOTE 

This tutorial assumes that the reader is using the Windows version of CDEGS. 

1.4 FILE NAMING CONVENTIONS 

It is important to know which input and output files are created by the CDEGS software. All CDEGS 

input and output files have the following naming convention: 

 

XY_JobID.Fnn 

 

where XY is a two-letter abbreviation corresponding to the name of the program which created the 

file or which will read the file as input. The JobID consists of string of characters and numbers that 

is used to label all the files produced during a given CDEGS run. This helps identify the 

corresponding input, computation, results and plot files. The nn are two digits used in the extension 

to indicate the type of file.  

The abbreviations used for the various CDEGS modules are as follows: 

Application Abbreviation  Application Abbreviation 

RESAP RS  FCDIST FC 

MALT MT  HIFREQ HI 

MALZ MZ  FFTSES FT 

TRALIN TR  SICL* SC 

SPLITS SP  CSIRPS* CS 

SESTLC TC  SESEnviroPlus TR 

SESShield LS  SESShield-3D SD 

GRSPLITS-3D SP  ROWCAD RC 

* The SICL module is used internally by the Input Toolbox data entry interface. The CSIRPS 

module is used internally by the Output Toolbox and GRServer – graphics and report 

generating interface. 
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The following four types of files are often used and discussed when a user requests technical support 

for the software:  

 .F05 Command input file (for engineering applications programs). This is a text file that can 

be opened by any text editor (WordPad or Notepad) and can be modified manually by 

experienced users. 

 .F09 Computation results file (for engineering applications programs). This is a text file that 

can be opened by any text editor (WordPad or Notepad).  

 .F21 Computation database file (for engineering applications programs). This is a binary file 

that can only be loaded by the CDEGS software for reports and graphics display.  

 .F33 Computation database file (for engineering applications programs MALZ and HIFREQ 

only). This is a binary file that stores the current distribution to recover. 

For further details on CDEGS file naming conventions and JobID, please consult CDEGS Help 

under Help | Contents | File Naming Conventions.  
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1.5 WORKING DIRECTORY 

A Working Directory is a directory where all input and output files are created. In this tutorial, we 

recommend the following Working Directory: 

 

C: (or D:)\CDEGS Howto\Fence\ 

 

 

You may prefer to use a different working directory. Either way, you should take note of the full 

path of your working directory before running CDEGS, as you will need this information to follow 

this tutorial. 

1.6 INPUT AND OUTPUT FILES USED IN TUTORIAL 

There are two ways to use this tutorial: by following the instructions to enter all input data manually 

or by loading the input files provided with the tutorial and simply following along. 

All input files used in this tutorial are supplied on your DVD. These files are stored during the 

software installation under documents\Howto\CDEGS\Fence (where documents is the SES software 

documentation directory, e.g., C:\Users\Public\Documents\SES Software\version, and version is the 

version number of your SES Software). Note that this folder is a distinct folder than the SES 

software installation directory, e.g, C:\Program Files\SES Software\version (where version is, again, 

the version number of your SES Software). 

Copying Input Files to Working Directory 

For those who prefer to load the input files into the software and simply follow the tutorial, you can 

copy all of the files from the documents\Howto\CDEGS\Fence directory to your working directory. 

After the tutorial has been completed, you may wish to explore the others How To…Engineering 

Manuals which are available as PDF files in your SES documents\Howto\ folder or on your SES 

Software DVD in the folder \PDF\Howto. 

If the files required for this tutorial are missing or have been modified, you will need to manually 

copy the originals from the SES Software DVD.Both original input and output files can be found in 

the following directories on the SES Software DVD: 

Input Files: Examples\Official\HowTo\CDEGS\Fence\inputs 

Output Files: Examples\Official\HowTo\CDEGS\Fence\outputs 

Note that the files found in both the ‘Inputs’ and the ‘Outputs’ directories should be copied directly 

into the working directory, not into subdirectories of the working directory. 
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CHAPTER 2 

DESCRIPTION OF THE PROBLEM BEING 

MODELLED 

Figure 2.1 illustrates the problem being modeled. A 3-phase 525 kV transmission line carries 430 A. 

The phase conductors are at a height of 20 m and the phase arrangement is as shown in Figure 2.1(a). 

A 200 m fence is located in the middle of the transmission line and is parallel to the line. A 

simplified model is used for the fence, namely a single loop of wire with two posts. Again, this is 

shown in Figure 2.1(a). The fence is 2.0 m high and its posts are secured to a depth of 0.5 m. Note 

that the phase-to-ground voltage of the 525 kV transmission line is 303.109 kV (= 525 kV /    , as 

shown in Figure 2.1. 

The transmission line phase conductor is a 1565 kcmil 36/7 ACSR conductor. The fence conductors 

are steel tubes with an inner radius of 1 cm and an outer radius of 2 cm. The steel has a relative 

resistivity of 12 (with respect to annealed copper) and a relative permeability of 250 (with respect to 

free space). The fence conductors are coated with a 0.5 mm layer of insulating material having a 

resistivity of 10 000 W-m. A uniform soil with a 100 W-m resistivity, a relative permittivity of 1 and 

relative permeability of 1 is assumed. 

 

Figure 2.1 Configuration of Transmission Line and Fence. (a) GPR and LEAD 

Energization. (b) VOLTAGE Energization. 
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Values for the voltages and currents induced on the fence and the electromagnetic fields along 

profiles 1 and 2 in Figure 2.1 are desired. The transmission line is assumed to be straight (to have no 

bends) over a considerable distance (1 km or more) on either side of the fence (If needed, the effects 

of bends could easily be modeled.). 

It is usually not practical to model the entire transmission line for such a study. A major 

consideration is therefore how much of the line should be modelled in order to obtain accurate 

results. The following rule of thumb can be used. Let dclose be the closest distance between a given 

observation point (a point at which the EM fields have to be computed) and the transmission line 

(Figure 2.2) and let dmax be the maximum value of dclose over all observation points. Then, the length 

of line that should be modelled on either side of every observation point is roughly 10  dmax. 

 

Figure 2.2 Definition of dclose 

In the case at hand, the fence and the profiles are roughly 20 meters below the line. The fence is right 

beneath the line and the profiles extend to 50 m on either side of the line. This means that dmax is 

obtained for observation points at the end of the profiles, i.e., dmax = 20 50 542 2   m.  For added 

safety, 700 m of the line were modelled on either side of the fence. Note that, in case of doubt, it is 

always possible to model a little more of the transmission line and verify that the results are indeed 

unaffected. 
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CHAPTER 3 

HOW TO PREPARE THE HIFREQ INPUT FILE 

The HIFREQ input file can be prepared using any of the interfaces listed below: 

 The SESCAD input mode 

 The CDEGS Windows Input Toolbox mode 

 The Command mode (or Plain Text Editor mode) 

The SESCAD and CDEGS Windows Toolbox input modes are used to generate a compatible ASCII 

input file which can be edited in Command mode (or Plain Text Editor mode). This generated input 

file (with the .F05 file extension) can be reloaded for modification at any time in SESCAD and in the 

CDEGS Windows input Toolbox. The .F05 file coresponding to our fence problem is shown in Figure 

B.1 in Appendix B (Command Input Mode). 

In the following sections, we will use the SESCAD input mode since its 3D graphical capabilities make 

the data input much easier. The preparation of the input file using the CDEGS Windows Input Toolbox 

can be found in Appendix A. 

3.1 PREPARATION OF THE HIFREQ INPUT FILE WITH 
SESCAD 

This section describes in detail how to prepare the HIFREQ data input file using SESCAD, a CAD 

program which allows you to create, modify, and view complex grounding networks and 

aboveground metallic structures visually, in three dimensions. The most important features of the 

data preparation are explained in Section 3.1.2. 

3.1.1 Start up procedures 

 
Click here 
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In the SES Software <Version> group folder, where <Version> is the version number of the 

software, you should see the icons representing Autogrid Pro, AutoGroundDesign, CDEGS, 

Right-of-Way, SESEnviroPlus, SESShield-3D and SESTLC software packages, as well as four 

folders. The Documentation folder contains help documents for various utilities and software 

packages. The Program Folders provides shortcuts to programs, installation and projects folders. 

The System folder allows you to conveniently set up security keys. Various utilities can be found in 

the Tools folder. The main function of each software package and utility is described hereafter.  

SOFTWARE PACKAGES 

 Autogrid Pro provides a simple, integrated environment for carrying out detailed grounding 

studies. This package combines the computational powers of the engineering programs RESAP, 

MALT and FCDIST with a simple, largely automated interface.  

 AutoGroundDesign offers powerful and intelligent functions that help electrical engineers 

design safe grounding installations quickly and efficiently. The time devoted to design a safe and 

also cost-effective grounding grid is minimized by the use of automation techniques and 

appropriate databases. This module can help reduce considerably the time needed to complete a 

grounding design. 

 Right-of-Way is a powerful integrated software package for the analysis of electromagnetic 

interference between electric power lines and adjacent installations such as pipelines and 

communication lines. It is especially designed to simplify and to automate the modeling of 

complex right-of-way configurations. The Right-of-Way interface runs the TRALIN and SPLITS 

engineering modules and several other related components in the background. 

 SESEnviroPlus is a sophisticated program that evaluates the environmental impact (radio 

interference, audio-noise, corona losses, and electromagnetic fields) of AC, DC or mixed 

transmission line systems. 

 SESShield-3D is a powerful graphical program for the design and analysis of protective 

measures against lightning for substations and electrical networks. Its 3D graphical environment 

can be used to model accurately systems with complex geometries. 

 SESTLC is a simplified analysis tool useful to quickly estimate the inductive and conductive 

electromagnetic interference levels on metallic utility paths such as pipelines and railways 

located close to electric lines (and not necessary parallel to them), as well as the magnetic and 
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electric fields of arbitrary configurations of parallel transmission and distribution lines. It can 

also compute line parameters. 

 CDEGS is a powerful set of integrated engineering software tools designed to accurately analyze 

problems involving grounding, electromagnetic fields, electromagnetic interference including 

AC/DC interference mitigation studies and various aspects of cathodic protection and anode bed 

analysis with a global perspective, starting literally from the ground up. It consists of eight 

engineering modules: RESAP, MALT, MALZ, SPLITS, TRALIN, HIFREQ, FCDIST and 

FFTSES. This is the primary interface used to enter data, run computations, and examine results 

for all software packages other than Right-of-Way, Autogrid Pro, AutoGroundDesign, SESTLC, 

SESShield-3D and SESEnviroPlus. This interface also provides access to the utilities listed 

below. 

TOOLS 

 AutoTransient automates the process required to carry out a transient analysis with the HIFREQ 

and FFTSES modules 

 CETU simplifies the transfer of Right-of-Way and SPLITS output data to MALZ. A typical 

application is the calculation of conductive interference levels in an AC interference study.  

 FFT21Data extracts data directly from FFTSES’ output database files (File21) in a spreadsheet-

compatible format or in a format recognized by the SESPLOT utility. 

 GraRep is a program that displays and prints graphics or text files. For more information on 

GraRep see Chapter 6 of the Utilities Manual or invoke the Windows Help item from the menu 

bar. 

 GRServer is an advanced output processor which displays, plots, prints, and modifies 

configuration and computation results obtained during previous and current CDEGS sessions.  

 GRSplits plots the circuit models entered in SPLITS or FCDIST input files. This program 

greatly simplifies the task of manipulating, visualizing and checking the components of a 

SPLITS or FCDIST circuit. 

 GRSplits-3D is a powerful interactive 3D graphical environment that allows you to view and 

edit the circuit data contained in SPLITS input files and to simultaneously visualize the 

computation results.  

 ROWCAD is a graphical user interface for the visualization and specification of the geometrical 

data of Right-of-Way projects. Its 3D graphical environment can be used to visualize, specify 

and edit the path data of Right-of-Way, and to define the electrical properties of those paths. 

 SESAmpacity computes the ampacity, the temperature rise or the minimum size of a bare buried 

conductor during a fault. It also computes the temperature of bare overhead conductors for a 

given current or the current corresponding to a given temperature, accounting for environmental 

conditions.  
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 SESBat is a utility that allows you to submit several CDEGS engineering program runs at once. 

The programs can be run with different JobIDs and from different Working Directories. 

 SESCad is a CAD program which allows you to create, modify, and view complex grounding 

networks and aboveground metallic structures, in these dimensions. It is a graphical utility for the 

development of conductor networks in MALT, MALZ and HIFREQ.  

 SESConductorDatabase gives access to the SES Conductor Database. It allows you to view the 

electrical properties of conductors in the database, and to add new conductors to the database or 

modify their properties. 

 SESEnviroPlot is a graphical display tool is an intuitive Windows application that dynamically 

displays arrays of computation data produced by the SESEnviro software module. 

 SESGSE rapidly computes the ground resistances of simple grounding systems, such as ground 

rods, horizontal wires, plates, rings, etc, in uniform soils. SESGSE also estimates the required 

size of such grounding systems to achieve a given ground resistance. 

 SESPlot provides simple plots from data read from a text file. 

 SESScript is a simple programming language that automatically generates input files for 

parametric analyses. 

 SESShield provides optimum solutions for the protection of transmission lines and substations 

against direct lightning strikes and optimizes the location and configuration of shield wires and 

masts in order to prevent the exposure of energized conductors, busses and equipment. It can also 

perform risk assessment calculations associated with lightning strikes on various structures. 

 SESSystemViewer is a powerful 3D graphics rendition software that allows you to visualize the 

complete system including the entire network and surrounding soil structure. Furthermore, 

computation results are displayed right on the system components. 

 SoilModelManager is a software tool that automates the selection of soil model structures that 

apply during various seasons. 

 SoilTransfer utility allows you to transfer the soil model found in several SES files into several 

MALT, MALZ or HIFREQ input (F05) files. 

 TransposIT is a tool for the analysis of line transpositions on coupled electric power line 

circuits. To ensure that voltage unbalance is kept within predefined limits, it allows the user to 

determine the optimal number of power line transpositions and their required locations. 

 WMFPrint displays and prints WMF files (Windows Metafiles) generated by CDEGS or any 

other software. 

During this tutorial, for simplicity, we will be using CDEGS Toolbox to carry out most of the output 

tasks. We will refer to these utility modules only when appropriate. 
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In the SES Software group folder, double-click the CDEGS icon to start the CDEGS program.  You 

will be prompted for a Working Directory and a Current Job ID. Enter the complete path of your 

working directory in the Working Directory box (or use the Browse button to find the directory). 

Any character string can be used for the Current Job ID. 

In the following session, we recommend the following Working Directory and Current Job ID as 

explained in Chapter 1: 

Working Directory: C: (or D:) \CDEGS Howto\Fence 

Current Job ID:  TUT1 

 

Figure 3.1 CDEGS Start Up Window 

3.1.2 SESCAD Input Mode For HI_TUT1.F05 

Select ‘Specify’ from the Session Mode drop-down list and click the SESCAD button (see below) or 

select SESCAD under Tools menu to start the SESCAD program. 

Specify Session 

Mode (Specify, 

Compute and 

Examine) 

Define Working 

Directory and 

Job ID 

Select  

Engineering 

Programs to use 
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In the Select a file to open window, select Open the HIFREQ file “HI_TUT1.F05”. In the 

SESCAD window, the following SESCAD screen will appear. You are now ready to input data. 

 

As illustrated in Section 1.4, the abbreviation “HI” means that this is a HIFREQ input file and the 

Job ID is “TUT1”. 

Click here to 

start SESCAD 
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In the following section, it is assumed that you are entering the data as indicated in the instructions. 

Note that it is advisable to save your work regularly using CTRL+S or Save Document As under the 

File menu. This file can be retrieved at any time by clicking on Open Document… under the File 

menu, if a data entry session has to be interrupted, then resumed. 

If you intend to enter the data for this example manually, proceed directly to Section 3.1.2.1. If you 

do not wish to do so, you can import all the data for this example by proceeding as follows: 

Importing DATA 

First be sure to close the HI_TUT1.F05 which was just created. Select the Open 

Document…under the File menu. Browse to the file HI_01A.F05 in the working directory 

\CDEGS Howto\Fence, then click on the OK button to open the file. Click on Save Document 

As… and select the file HI_TUT1.F05 in working directory to overwrite this file. The data 

described in the next section will be loaded and you will not have to enter it. 

3.1.2.1 Data Entry for HI_TUT1.F05 

Step 1. Define Run ID and System of Units: This 

is done by selecting the Define | Units and 

Other Settings menu item in SESCAD. 

Under the Case Description block of this 

window, you can enter comment lines that 

are used to describe the case. These are 

echoed in the HIFREQ output (.F09 file). 

In this tutorial, “EXAMPLE1-GPR” is 

entered under the Specify option, and the 

Metric System of Units is chosen with 

radius in meters. Note that a Run ID is 

different from the Job ID. The run-id is 

useful in identifying all the plots which will 

be made later in Section 5-1. Click the OK 

button to return to the SESCAD screen. 

 

 

Step 2. Define Soil Structure: This is done by clicking on the Define | Soil Model menu 

item. The following screen appears with many choices of soil structure. HIFREQ 

supports horizontally layered soils with any number of layers: Uniform, Horizontal – 

2 Layers, Horizontal – 3 Layers and Horizontal – Multilayers. It also supports 

Infinite Medium soil model. Select Uniform soil. The data entry fields under the 

Soil Characteristics frame allow you to define the properties for the air and the 

different soil layers. In this example, a default 100 Ω-m uniform soil is used. Click 

the OK button to return to the SESCAD main screen. 
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Step 3. Define Conductor Types: Two types of conductors are encountered in this study: A 

1565 kcmil 36/7 ACSR for the phase conductor and a steel tube for the fence. These 

two conductor types are specified by selecting the Define | Conductor Types menu 

item and entering the data, which includes resistivity, permeability, internal radius 

and load of the conductor. 

 

Conductor type No. 1 is defined as aluminum (1565 kcmil 36/7 ACSR) and 

Conductor Type No. 2 is defined as a steel tube with an inner radius of 1 cm. The 

steel has a relative resistivity of 12 (with respect to annealed copper) and a relative 

permeability of 250 (with respect to free space). Conductor Type No. 0 is a default 

conductor, which is pure copper, unless it has been redefined. Once the properties of 

the conductors have been defined, click OK to return to the SESCAD window. 

Step 4. Define Coating Types: The coating type for the fence conductors can be specified by 

selecting the Define | Coating Types menu item in SESCAD. 
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Coating Type No. 1 is identified with the name "Fence Coating"; it is a 0.5 mm thick 

insulating layer of a material with a resistivity of 10
4
 W-m. The two other coatings 

(Insulated and Default Coating)  are SES default coating types that represent 

respectively perfect coating and no coating at all.  

With the conductor types and coating types defined, we can now define the 525 kV 

transmission line and the fence posts. 

Step 5. Define 525 kV Transmission Line: The 525 kV transmission line shown in 

Figure 2.1(a) can be easily created by using the option called Right-of-Way 

Model under the Insert menu in SESCAD. The following provide the steps: 

a. Define Reference Path: Select the Insert | Right-of-Way Model menu 

item, the following window will appear (first without any data) to let you 

define the Reference Path which is the center line of the 525 kV 

transmission line. Note that the Reference Path is defined in the X-Y 

plane. Each segment along the Reference Path can be either defined by 

their XY coordinates or by their lengths and angles. By default, the 

Reference Path is at the Common Depth (m) = 0 m (the earth surface). In 

this example, we define the Reference Path along the X axis from X = - 

800 m to X = + 800 m. 
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b. Define Cross-Section: Click the Cross-Section tab, enter the data in the 

following screen which defines Type (Conductor or Profile), Conductor 

Name, Horizontal Offset and Vertical Offset from the Reference Path. 

There are three conductors to be defined. Enter PhaseA, PhaseB and 

PhaseC under the Name column. In the drop-down list under the Type 

column, select Conductor. Enter Horizontal Offset per Figure 2.1(a). 

Note that by convention, the direction of the Reference Path is defined 

from the start to the end of the path and the positive X-axis is in the same 

direction as the Reference Path. Therefore, Phase A is at +10 m and Phase 

C at -10 m. The Vertical Offset 
1
 defines the offset from the Common 

Depth which is at Z = 0 m. Z = -20 is entered for the phase conductors as 

they are above ground. The drop-down menu under the Connected 

column controls whether one wishes to connect a conductor to the 

connection point (usually overhead shield wires) defined in the Structure 

tab (see next). In this case, we select No since these are phase conductors.  

                                                 

1
 Note that, for HIFREQ, the z coordinates is negative when the conductor is above grade in air and positive when it is in 

the soil. 



Chapter 3.  How to Prepare the HIFREQ Input File 

Page 3-11 

 

Finally, we assign characteristics to 

each phase conductors. First, click on 

the first Conductor under the Type 

column. Click on the Characteristics 

button to see the window to the right. 

Select Conductor Type No. 1 

Aluminium under Conductor Type. 

Enter a radius of 0.0191 m for a 1565 

kcmil 36/7 ACSR conductor. This 

defines Phase A. Repeat the same for 

Phase B and Phase C. 

The Subdivision Options controls 

how a conductor is subdivided and the 

number of subdivisions 
2

. This is 

important if one is to accurately 

compute leakage currents and GPR 

                                                 

2
 Node Subdivision option in HIFREQ subdivide conductors where they intersect each other while Presubdivide option in HIFREQ subdivides the 

conductors according to the individual subdivision  specified through SESCAD or Windows Input Toolbox. By default, both Presubdivide and Node 

Subdivision are selected. Thus, HIFREQ first subdivides all conductors at the crossing nodes, which is a good choice as long as node subdivision does 

not result in the generation of an excessive number of segments. Then HIFREQ continues to subdivide the largest segments until the specified 

individual subdivision number is reached. 

 

Click here to define 

Conductor Characteristics 
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drops along a very long conductor (for example along the fence in this 

example).. 

In this example, phase conductors are not subdivided as we are not 

interested in the GPR of phase conductors. 

c. Define Structures: In this example, there are no transmission line 

sturctures to be defined. 

d. Define Terminations of Transmission Lines Using Current and GPR: 
As shown in Figure 2.1, there are two ways to model the energization of 

the transmission line: one using VOLTAGE energization, and the other a 

combination of Current (or LEAD) and GPR energizations. When the 

phase voltages with respect to ground are constant or can be assumed to be 

relatively constant along the portions of the transmission line being 

modelled (as is the case here), the most convenient way to energize the 

network is to use the Current (or LEAD) and GPR combination. However, 

the VOLTAGE energization combined with the inclusion of an 

appropriate load is the most accurate model since it will correctly show the 

phase potential variations along the transmission line length. The use of 

the VOLTAGE and Impedance energization is described later. The 

energization of Current and GPR is illustrated below. 

As shown in Figure 2.1(a), each phase conductors A, B and C carries 

430 A and is maintained at a potential of 303.109 kV with respect to 

ground. The phase angle of the current and potential for Phase A, B and C 

are -120, 0 and 120 degrees respectively. Click on the Terminations tab. 

Select the Current and GPR energizations. Enter the data in the 

following screen: 
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As shown Figure 2.1(a), the GPR Energization is applied At the 

beginning of line. The Length of Energized Conductors is changed 

from 1 m (default) to 0.5 m.  

 

Click OK to return to the SESCAD main screen. The transmission line is energized. 

Step 6. Define Fence: The coordinates and characteristics of the fence in Figure 2.1 is 

provided in. They correspond to Conductors C10 – C13 in Table 3.1 below.  

Cond. 

No. 

XS YS ZS XP YP ZP Radius 

(m) 
Nsub Cond Coat Bus 

(Origin) (End) 

C10 -80 0 -2 120 0 -2 0.02 5 2 1 0 

C11 -80 0 -1 120 0 -1 0.02 5 2 1 0 

C12 -80 0 -2 -80 0 0.5 0.02 1 2 1 0 

C13 120 0 -2 120 0 0.5 0.02 1 2 1 0 

Table 3.1 Conductors data 

They can be defined by selecting the Edit | Create Object menu item in SESCAD. In 

the Create Object screen, select Single Conductor. The following screens provide 

the input data for Conductor C11. Click on the Characteristics button to define 

Conductor Types and Coating Types. The fence post is defined by Conductor Type 

No. 2 and Coating Type No. 1. The radius of the fence post is 2 cm. Click on the 

Apply button. This will create Conductor C11 (move the Create Object screen to see 

this conductor). Keep the Create Object window open, you can create Conductors 

C11, C12 and C13 by modifying their coordinates per and by clicking on the Apply 

button each time. Click on Close to return to SESCAD window. 
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Step 7. Define Computation Profiles: In this example, the electric and magnetic fields will 

be computed at a single frequency (60 Hz) for profiles 1 and 2 as shown in Figure 2.1. 

The profiles P1 and P2 are located at X = 0.0 and are perpendicular to the 

transmission line. They are at a height of 0.01 m and 1.6 m above the earth surface, 

respectively. The profiles extend 50 m on both side of the line. The points on each 

profiles start at Y = -50 m with a 1m increment.  

Select the Edit | Create Object menu item. In the following Create Object screen, 

select the Single Profile radio button and enter the coordinates for Profile 1. Specify 

1 m for the Distance between points (increment) and click Apply. This creates 

Profile 1. Change Z from -0.01 m to 1.6 m, click on Apply. This creates Profile 2. 

As you may have already noticed, HIFREQ uses a Cartesian coordinates system with 

the Z axis directed downwards. When the height of the observation points are 

precisely zero (i.e., the observation points are lying at the air-soil interface), HIFREQ 

assumes that the points are in the ground. If the fields close to the air-soil interface 

but in the air are desired, an observation profile must be specified at a small height 

above the ground. This is the reason behind the choice of a height of -0.01 m for 

Profile 1.  
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We have now completed the preparation of the data. Under the File menu, select Save Document. 

If you are a licensee of the CDEGS software you will be able to proceed to Chapter 4. Users of the 

demo software are not able to process the input file, but are able to peruse all output files which are 

already available. In this case, you may read Chapter 4 for reference only. Any attempt to start the 

engineering modules will result in a message stating that the Engineering module is not active. 

3.1.3 SESCAD Input Mode For HI_01B.F05 

As mentioned in Step 5(d) of the preceding section, alternatively, we can also energize the 

transmission line by using the Voltage and Impedance energizations.  This creates a HIFREQ file 

called HI_01B.F05 which is available in your CDEGS directory. See Section 1.6 for the location of 

this file. The steps to create the HI_01B.F05 is the same as those for HI_TUT1.F05 ( HI_01A.F05), 

therefore, we will only describes Step 5(d). 

In the Termination tab in the Create Right-of-Way screen, you must enter the voltages and the 

corresponding load impedances to get the correct current. A resistance of 704.9 W (which is much 

larger than the impedance of the wires) will give a current of 430 A as before. Also, you will need to 

select the option At the End of line in order to have the voltage source in the right-hand side so that 

the current is flowing in the same direction as before.  

Click here to start 

Quick Info 
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With the Voltage and Impedance energization, the voltage source must be 

physically grounded 
3
.  Click on the Grounding Options to get the following 

window. Select Ground Rod and specify 10 m for the rod length. Click on the Base 

Characteristics to specify the characteristics of the rod. In our example, we used the 

same material as the phase wire i.e. 1565 kcmil 36/7 ACSR and we subdivided the 

rod into 5 segments. 

    

 

                                                 

3
 This wasn't needed in the case of Current-GPR energization because the pseudo-nodes of the current and GPR 

energization segments behaves as  if they were connected to remote.  

Click here to define 

grounding of voltage 

source 
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CHAPTER 4 

HOW TO SUBMIT THE HIFREQ RUN 

There are two ways to submit the HIFREQ runs. 

4.1 SUBMIT ENGINEERING PROGRAM USING SESCAD 

You can submit the engineering run directly from SESCAD, by selecting the Run/Reports | Save & 

Run menu item. This will start the SESBatch program and automatically run the engineering 

module.  Note that for illustration purposes, the generic grounding grid shown in the following 

screen shot has been used instead of the specific case discussed in this How To manual. 

 

Once the run is complete, a window will pop up to inform you that a log file has been generated. 

Click the OK button to close the message window. SESBatch allows you to conveniently access 

some of the important files that it generates. For example, from the Tools | View Run Log File… 

menu item you can view the log file generated during the computations. From the Tools | View 

Output File… menu item you can view the output file, which may contain ERROR or WARNING 

messages requiring your attention. Finally, you can launch Output Toolbox directly from the Tools | 

View Results with Output Toolbox… menu item. 
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4.2 SUBMIT ENGINEERING PROGRAM USING CDEGS 

In this section, the two input files prepared in the last section will be submitted to HIFREQ. We can 

start with JobID TUT1. Select ‘Compute’ from the Session Mode drop-down list. 

The HIFREQ program will start and will carry out all requested computations. The run should take 

very little time. At completion, the program will produce three important files: an OUTPUT file 

(HI_TUT1.F09), a REPORT file (HI_TUT1.F17) and a DATABASE file (HI_TUT1.F21). These 

files are already in your working directory. 

The OUTPUT and REPORT files are ASCII files, while the DATABASE file is a binary file. Any 

ERROR or WARNING messages generated during the HIFREQ run will appear in the OUTPUT 

file. You can view the output file by clicking on the File Viewer ( ) button in the Output section 

of the toolbar. You can also use the GraRep  utility (See Section 3.1.1) to view and edit any ASCII 

output files. 

The next section looks at the computation results using the Examine (Output) mode of CDEGS. 

Depending on your settings, the program may automatically start the output session the moment the 

engineering program terminates. This is controlled by the option View the output session after 

engineering computations in the “System Settings” window (accessible from the Settings | System 

menu item). 
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CHAPTER 5 

HOW TO EXTRACT RESULTS FROM HIFREQ 

OUTPUT FILES 

The OUTPUT file contains all the information from your HIFREQ run. It contains the current 

distribution and the ground potential rise (GPR) for each conductor segment, as well as the requested 

scalar potentials and electromagnetic fields computed at the specified observation points. With the 

SES Text viewer or any other text editor, searching for the string "Leaking" will get you to the 

location of current distributions of segments quickly, searching for the string "Scalar" will get you to 

the location of the GPR or scalar potential quickly, and so on. The REPORT file only contains the 

conductor information and the current distribution for each conductor segment. It is written in a 

format such that this file can be readily appended to your original input file for a second round of 

computations where the current computation will be bypassed. Note, however, that this feature 

should not be used when above ground conductors are involved since the currents are not stored to a 

high enough precision for such use. 

The DATABASE file is normally used by the Windows Output Toolbox and the SES Interactive 

Report & Plot Software processors (such as GraRep) to display the computation results. The 

computation results can be classified into two categories: CONFIGURATION plots and 

COMPUTATION plots. The CONFIGURATION plots allow you to view the conductor network, to 

label the conductor segments with their GPR, longitudinal and leakage currents, and so on. The 

COMPUTATION plots allow you to examine the scalar potential and the electromagnetic fields 

computed at selected observation points. In the following, we will give several examples to show 

how to use the Windows Toolbox interface (Section 5.1) to produce the corresponding graphs. 

5.1 WINDOWS MODE OUTPUT PROCESSOR 

If the CDEGS-Examine-HIFREQ screen is not already visible, click on the  (Examine) button 

on the toolbar, and click No if prompted to save: the CDEGS-Examine-HIFREQ screen will appear 

and you are now ready to make Computations plots or Configuration plots. 

Figure 5.1, Figure 5.2 and Figure 5.3 show the longitudinal currents, leakage currents and GPR on 

the conductor network, respectively. The plots are obtained with the HIFREQ (Configuration) 

screen. As shown in the figure below, the Plot Title box allows you to specify the title of the plot. 

To choose which data will be ploted, select Longitudinal Current Flowing in Origin of 

Conductor for the Data Type. Then, to make the figure easier to read, specify an Expansion 

Factor of 10 in the Y-exp and Z-exp boxes to magnify the plot 10 times along the Y and Z 

directions. 

Click Plot/Draw to produce a plot on screen. The plot is shown in the GraRep utility. From GraRep 

you can print your plot or save the plot to a file. 
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Figure 5.1 Longitudinal Current on a Transmission Line and Fence 

(a)

(b)

Select 

Data Type 
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Figure 5.2 Leakage Current on a Transmission Line and Fence 

 

 

Figure 5.3 GPR on the Transmission Line and Fence 

(a)

(b)

(a)

(b)
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To plot the leakage currents (Figure 5.2(a)), 

simply select Leakage Currents of Conductor 

Segments in the Data Type list and click 

Plot/Draw. To plot the ground potential rise 

(GPR) of the conductors (Figure 5.3(a)), select 

GPR of Conductor Metal in the Data Type list 

and click Plot/Draw. Note that for these last two 

plots, the Expansion Factors are still in effect. 

You have probably noticed that the labeling on 

the fence is rather crowded. To view this area 

more clearly, you can specify a larger 

magnification in the Expansion Factors block, 

(for example ‘1, 1, 50’). Another approach, which 

will be used here, consists in “zooming-in” on the 

area of interest.  Select the option Zoom Polygon 

under Conductor Selection. The four data entry 

fields P1 to P4 define a rectangular surface in the 

X-Y plane, and the Depth defines the top and 

bottom plane to form a rectangular box. All of the 

conductors falling inside this box will appear in 

the plot. An Expansion factor of  ‘0.5, 15, 15’ 

was used for added legibility of the labels. For 

the same reason, the default value for the size of the characters used in labeling will be bypassed. 

From Settings on the main menu bar, click Setup; a window like the one below will appear. Under 

Character Labeling, select the User-defined option and adjust the Character Height to 0. 4 cm. 

Then, click OK. 

    

Figure 5.1 (b), Figure 5.2(b) and Figure 5.3(b) can now be obtained by repeating the steps that lead 

to Figure 5.1(a) to Figure 5.3(a). 
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Please note that Longitudinal Current Flowing in Origin of Conductor that was used to generate 

Figure 5.1 plots the magnitude of the longitudinal current in each segment and the arrows indicate 

the direction of the real part of the longitudinal current flow. To plot both the real and imaginary 

parts of the longitudinal currents, you will find a Data Format list just below the Data Type.  Select 

Real and Imaginary Parts
4
 in the list and click Plot/Draw. Figure 5.4 shows the results. 

  

Figure 5.4 Real and Imaginary Parts of the Longitudinal Current on the Fence 

Now, click the Computations radio button (below 

the icons groups) in order to plot the 

electromagnetic fields along the profiles defined in 

the HIFREQ input. The following screen should 

appear. 

Enter the data shown in the screen and click 

Plot/Draw to plot the Z-component of the electric 

field (Figure 5.5). 

                                                 

4
 This Data Format is available only if Text is selected for the Labeling Style. 
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Figure 5.5 Electric Field Under the Fence 

To plot the Z-component of the magnetic field (Figure 5.6), select Magnetic Fields under Report 

Computation Results for. Then select Z-component of field in the Determine list. The Plot Title 

can be changed to "example 1: magnetic field".  Then, click Plot/Draw. 

 
Figure 5.6 Magnetic Field under a Fence 

Once you are done examining the results, click  in the toolbar to go back to the CDEGS startup 

screen.
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CHAPTER 6 

CONCLUSIONS 

This concludes our concise step-by-step instructions on how to prepare, submit and examine results 

for the HIFREQ, Electromagnetic Field Analysis Engineering module. 

As already mentioned, you can accomplish all these operations by using SES different input and 

output processors. The results are essentially the same. 

Only a few of the many features of the software have been used in this tutorial. You should try the 

many other options available to familiarize yourself with the CDEGS software package. Your SES 

Software DVD also contains a wealth of information stored under the PDF directory. There you will 

find the Getting Started with SES Software Packages manual (\PDF\getstart.pdf) which contains 

useful information on the CDEGS environment. You will also find other How To…Engineering 

Guides, Annual Users’ Group Meeting Proceedings and much more. All Help documents are also 

available online. 
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APPENDIX A 

WINDOWS INPUT TOOLBOX 
This section describes in detail how to prepare the HIFREQ data input file by using the Windows 

Toolbox Input Mode. The most important features in preparing the data are explained in Section 

3.1.2, which also describes some tricks on how to avoid common input problems. The instructions 

describing how to run the HIFREQ input file once the data is entered are given in Chapter 4. 

A.1 DATA ENTRY 
Select Specify in the Session Mode list, then click the HIFREQ button located in the CDEGS main 

screen. The CDEGS-Specify-HIFREQ screen will appear (without the text) and you are now ready 

to input your data. 

    

In the following section, it is assumed that the reader is entering the data as indicated in the 

instructions. At anytime, you can obtain relevant context-sensitive information about any Input or 

Output text field by clicking on it and pressing the Help Key (F1). However, if you do not wish to 

enter the data manually, you can import all the data by proceeding as follows: 
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Importing DATA 

Click the Import/Load  button. Change the File Name in the dialog box to HI_01A.F05 then 

click on the Load button in the dialog box. The data described in the next section will be loaded 

and you will not have to enter it. 

First, we will start the project by entering a description of the case to be analyzed in the Module 

Description tab. This description is optional but very useful since it will appear later in the HIFREQ 

output. This is also the case for the run-id. In our fence project, the run-id EXAMPLE 1 GPR is 

entered in the Run-Identification data entry field (select the Specify option instead of the Use 

JobID to enter the run-id name). The Run-ID is useful in identifying all the plots which will be made 

later in this tutorial. Finally, the Metric System of Units is chosen. 

Now, the soil structure is defined by clicking on  Soil Type  

in the bottom of HIFREQ's specify window (see figure 

above). The following screen will appear. HIFREQ supports 

horizontally layered soils, with any number of layers 

(Uniform, Horizontal – 2 Layer, Horizontal – 3 Layer 

and Horizontal – Multilayer): It also supports an Infinite 

Medium soil model. Select a Uniform soil. The data entry 

fields under Soil Characteristics allow you to define the 

properties of the air and earth. In this example, the default 

properties for both the air and the earth (a soil with 

resistivity of 100 W-m, relative permeability and relative 

permittivity of 1) are used. You can therefore simply click 

OK to return to the HIFREQ main screen. 

 

In the SYSTEM module, which is invoked by clicking on the System button, the characteristics of 

conductors such as Conductor Types, Coating Types as well as the specified Conductor Currents 

and Energization modes are defined in the Define block. Then, the conductor network is entered 

and energized under the Main-Ground Conductors block. The Subdivision block allows you to 

specify the total number of conductor segments desired.  
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Two types of conductors are encountered in this study: A 1565 kcmil 36/7 ACSR for the phase 

conductor and a steel tube for the fence. These two conductor types are specified by clicking on the 

Conductor Types button and entering the data, which includes resistivity, permeability, internal 

radius and load of the conductor.  

 

Conductor type No. 1 is defined as aluminum (1565 kcmil 36/7 ACSR) and Conductor Type No. 2 is 

defined as a steel tube with inner radius of 1 cm. Conductor Type No. 0 is a default conductor, which 

is pure copper, unless it has been redefined. Once the properties of the conductors have been defined, 

click OK to return to the HIFREQ (System) screen. 

Now, the coating type for the fence conductors can be specified in the Coating Types block: 
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Coating Type No. 1 is identified with the name "Fence Coating"; it is a 0.5 mm thick insulating layer 

of a material with a resistivity of 10
4
 W-m. The two other coatings (Insulated and Default Coating)  

are SES default coating types that represent respectively perfect coating and no coating at all.  

Now, there are two ways to model the energization of the transmission line: one using VOLTAGE 

energization, and the other a combination of LEAD and GPR energizations. When the phase 

voltages with respect to ground are constant or can be assumed to be relatively constant along the 

portions of the transmission line being modelled (as is the case here), the most convenient way to 

energize the network is to use the LEAD and GPR combination. However, the VOLTAGE 

energization combined with the inclusion of an appropriate load is the most accurate model since it 

will correctly show the phase potential variations along the transmission line length. The use of the 

VOLTAGE energization is described later. The energization of Lead and GPR is illustrated below.  

As shown in Figure 2.1(a), each of Phase conductors C, B and A carries 430 A and is maintained at a 

potential of 303.109 kV with respect to ground. The phase angle of the current and potential for 

Phase C, B and A are 120, 0 and -120 degrees respectively. The energizations for this problem are 

defined by clicking on the Energization button in the HIFREQ (System) screen.The six LEAD and 

GPR energizations are entered in the opening window as shown in the figure below . Bus No. 1 is a 

LEAD energization with current 430e
-j120

 A, Bus No. 5 is a GPR energization with potential 

303109e
j0

 Volts, and so on. Once the data is entered, click OK to return to the HIFREQ (System) 

screen. 
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With the conductor type, coating type and energization type specified, the conductor networks can 

now be defined and energized in the Main-Ground Conductors block in the HIFREQ (System) 

screen. The characteristics of conductors and their energizations are attributed by selecting the 

appropriate code (pointer) number in the data entry field under Main-Ground Conductors. Note 

that you must scroll the window horizontally to access all of the data entry fields. 

 

The 1.6 km long Phase conductor A in Figure 2.1(a), which extends from 800.0 -=Xs m to  

800.0 =Xp   m and is at 20 m above the earth surface, is defined by C1 in the above screen. The 

radius of 1565 kcmil 36/7 ACSR is 0.0191 m. The coordinates (Xs, Ys, Zs) specify the origin of the 

conductor and (Xp, Yp, Zp) specify its end. The Number of Segments of Phase A is 1. The 

Conductor Type 1 selects the first conductor type for this conductor, i.e., 1565 kcmil 36/7 ACSR. 

The Coating Type 0 selects the first coating type, i.e., no coating. The Bus Number 0 means this 

conductor is connected to Bus No. 0, i.e., no energization.  

The LEAD (current) type energization of Phase A is carried out by C7, which attaches a 0.5 m long 

conductor at X = +800.0 m. The conductor is connected to Bus Number 4, which is defined to be a 

lead type energization with current 430e
-j120

 (see above). A current of 430 A is injected into the 

phase conductor from Xp = 800.5 m towards 800 =Xs  m. Note that a completely different situation 

occurs if the X coordinates of the origin and end of this conductor are interchanged. In this case, the 

program would force the current to be zero at X = 800.5 m since this point is not connected to any 

other conductors and the result would be that the entire 430 A would have to leak between X = 800 

m and X = 800.5 m, generating huge potentials and electric fields.  
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Now, the potential on the phase conductor is clamped to 303.109 kV by applying a GPR type 

energization  to a 0.5 m long conductor at X = -800.0 m using conductor C4,. The Bus Number 

refers to an energization of type 1. The GPR energization will, at the same time, absorb all the 

current flowing in the Phase wire A at the conductor end corresponding to X = -800 m since currents 

cannot be allowed to leak into the air from the end of a conductor.  

The other phases are energized in a similar way. Including the fence, there are ten more conductors 

to be entered. The data is provided in Table A.1. 

 XS 

(Origin) 

YS 

(Origin) 

ZS 

(Origin) 

XP  

(End) 

YP  

(End) 

ZP  

(End) 

 

Radius 

 

Nsub 

 

Cond 

 

Coat 

 

Bus 

C4 800.5 0.0 -20.0 800.0 0.0 -20.0 0.0191 1 1 0 2 

C5 800.0 0.0 -20.0 -800.0 0.0 -20.0 0.0191 40 1 0 0 

C6 -800.5 0.0 -20.0 -800.0 0.0 -20.0 0.0191 1 1 0 5 

C7 800.5 10.0 -20.0 800.0 10.0 -20.0 0.0191 1 1 0 3 

C8 800.0 10.0 -20.0 -800.0 10.0 -20.0 0.0191 40 1 0 0 

C9 -800.5 10.0 -20.0 -800.0 10.0 -20.0 0.0191 1 1 0 6 

C10 -80.0 0.0 -2.0 120.0 0.0 -2.0 0.02 5 2 1 0 

C11 -80.0 0.0 -1.0 120.0 0.0 -1.0 0.02 5 2 1 0 

C12 -80.0 0.0 -2.0 -80.0 0.0 0.5 0.02 1 2 1 0 

C13 120.0 0.0 -2.0 120.0 0.0 0.5 0.02 1 2 1 0 

Table A.1:   Data Regarding the Remaining Conductors 

As explained previously, voltage energizations can also be used to energize the transmission line. 

Figure 2.1(b) shows the configuration which applies in this case. The VOLTAGE energization 

allows for more realistic modelling at the expense of a little bit more work. In this case, we need 

three VOLTAGE energizations, one for each phase. Furthermore, an impedance, typically a resistor, 

must be attached to each phase to limit the current flow. A resistance of 704.9 W (which is much 

larger than the impedance of the wires) will give a current of 430 A, as before. A Windows Toolbox 

input file HI_01B.F05 for the voltage energization is available in your CDEGS directory. As usual, 

this file can be imported using Import/Load in the main HIFREQ screen. 

 You can have a look to the configuration of your conductors network  by clicking on Show Data 

(see figure below). Use the Top View, Side View and Animate buttons as required. The Animate 

button will rotate the conductor network automatically. By holding down the Control or Shift Keys 

on your keyboard and moving your mouse, while pressing the left button, you can rotate the grid and 

zoom in or out to the grid respectively. Consult the on-line help for more detailed instructions on 

how to view the conductor network in several useful ways. 
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Return to the HIFREQ main screen by clicking OK. The COMPUTATIONS module, which is 

invoked by clicking on Computations button in the HIFREQ main screen, defines the physical 

quantities to be computed, the location of the observation points where these quantities are to be 

computed and the frequencies at which the computations are to be carried out. 

In this example, the electric and magnetic fields 

are computed at profiles 1 and 2 (as shown in 

Figure 2.1) for a single frequency (60 Hz). The 

two Profiles (P1 and P2) are at X = 0.0 and 

perpendicular to the transmission line. Profiles 1 

and 2 are at a height of 0.01 m and 1.6 m above 

the earth surface, respectively. They start at Y = -

50 m with 1 m increment. Please note that 

HIFREQ uses a Cartesian coordinates system 

with the Z axis directed downwards. 

When the height of the observation point is 

precisely zero (i.e., the observation point lies at 

the air-soil interface), HIFREQ assumes that the 

point is in the ground for the purpose of 

calculating the electric and magnetic fields. If the 

fields in the air but close to the air-soil interface 

are desired, an observation profile must be 

specified at a small height above the ground. This is the reason behind the choice of a height of 0.01 

m for Profile 1. 
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APPENDIX B 

COMMAND INPUT MODE 
Any of the interfaces listed below or a text editor can be used to prepare the input data. The 

Windows Toolbox and SESCAD input modes convert the results of an input session to a 

Command Mode compatible ASCII input file which can be edited at any time. This file document 

and its architecture will be presented in more detail below. 

Printout B.1 is the HIFREQ file which describes completely the problem being modelled.  It is 

available in your CDEGS working directory under the name HI_01A.F05. This HIFREQ file is 

created directly by an experienced user or is automatically produced when using one of the above-

listed input interface modules. Similar files can be prepared quite easily by following the 

information contained in the template shown in Figure B.1. As shown in Figure B.1, the HIFREQ 

commands are grouped into modules, reflecting the hierarchical nature of the SES Input 

Command Language. Each module of Figure B.1 (with the exception of the OPTION module) is 

associated to a button in the HIFREQ screen. The OPTION module is actually part of the 

HIFREQ main screen. 

HIFREQ 

 

TEXT,MODULE,This example illustrates how to study induced currents and 

TEXT,MODULE,voltages on a simplified fence located below a 1.6 km long 

TEXT,MODULE,three phase transmission line. The transmission line carries 

TEXT,MODULE,430 A and is at 303 kV with respect to ground. 

TEXT,MODULE,LEAD and GPR energizations are used. 

OPTIONS 

UNITS,METRIC 

RUN-IDENTIFICATION,EXAMPLE1-GPR 

COMPONENTS 

GROUP,Right-of-Way,0,0,,,, 

GROUP,Parallel Lines,1,0,,,, 

GROUP,PhaseA,2,0,,,, 

GROUP,PhaseB,2,0,,,, 

GROUP,PhaseC,2,0,,,, 

GROUP,Terminations,1,0,,,, 

GROUP,GPR Energization,6,0,,,, 

GROUP,Current Energization,6,0,,,, 

 

SOIL-TYPE,LIMITED-LAYER 

UNIFORM,EARTH,100.,1.,1. 

SYSTEM 

TOLERANCE,0.001,1.,0.005,0.00005,0.001,0.,0.,0.,0.5 

ENERGIZATION,GPR-Potential,-151554.,-262500.,,,,,,PhaseA - GPR 

ENERGIZATION,GPR-Potential,303109.,0.,,,,,,PhaseB - GPR 

ENERGIZATION,GPR-Potential,-151554.,262500.,,,,,,PhaseC - GPR 

ENERGIZATION,Lead,-215.,-372.391,,,,,,PhaseA - Lead 

ENERGIZATION,Lead,430.,0.,,,,,,PhaseB - Lead 

ENERGIZATION,Lead,-215.,372.391,,,,,,PhaseC - Lead 

CHARACTERIST 

CONDUCTOR-TY,Computed,1.64,1.,0.,,0.,0.,0.,0.,Aluminium 
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CONDUCTOR-TY,Computed,12.,250.,.01,,0.,0.,0.,0.,Fence Post 

COATING-TYPE,DEFAULT,1.0,0.0,1.0,1.0, Default Coating 

 

REACTIVE-PART,PERMITTIVITY 

 

COATING-TYPE,,10000.0,0.0005,1.0,1.0,Fence Coating 

 

REACTIVE-PART,PERMITTIVITY 

 

 

 

SUBDIVISION,YES, 

SOIL-INTERFACE-OPTION,ERROR 

NETWORK 

MAIN-GROUND 

CONDUCTOR,-1,1,0,0,-800.,-10.,-20.,800.,-10.,-20.,.0191,1,3,, 

CONDUCTOR,-1,1,0,0,-800.,0.,-20.,800.,0.,-20.,.0191,1,4,, 

CONDUCTOR,-1,1,0,0,-800.,10.,-20.,800.,10.,-20.,.0191,1,5,, 

CONDUCTOR,0,1,0,1,-800.5,-10.,-20.,-800.,-10.,-20.,.0191,1,7,, 

CONDUCTOR,0,1,0,2,-800.5,0.,-20.,-800.,0.,-20.,.0191,1,7,, 

CONDUCTOR,0,1,0,3,-800.5,10.,-20.,-800.,10.,-20.,.0191,1,7,, 

CONDUCTOR,0,1,0,4,800.5,-10.,-20.,800.,-10.,-20.,.0191,1,8,, 

CONDUCTOR,0,1,0,5,800.5,0.,-20.,800.,0.,-20.,.0191,1,8,, 

CONDUCTOR,0,1,0,6,800.5,10.,-20.,800.,10.,-20.,.0191,1,8,, 

CONDUCTOR,-1,2,1,0,-80.,0.,-1.,120.,0.,-1.,.02,5,0,, 

CONDUCTOR,-1,2,1,0,-80.,0.,-2.,120.,0.,-2.,.02,5,0,, 

CONDUCTOR,-1,2,1,0,-80.,0.,-2.,-80.,0.,.5,.02,5,0,, 

CONDUCTOR,-1,2,1,0,120.,0.,-2.,120.,0.,.5,.02,5,0,, 

 

COMPUTATIONS 

DETERMINE 

MAGNETIC,YES 

ELECTRIC,YES 

POTENTIAL-SC,YES 

OBSERVATION-POINTS 

PROFILES,101,0.,-50.,-.01,0.,1.,0.,0 

PROFILES,101,0.,-50.,-1.6,0.,1.,0.,0 

FREQUENCY,60.,60. 

 

ENDPROGRAM 

Printout B.1 HIFREQ Input File 
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Figure B.1 HIFREQ Input File Template 
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APPENDIX C 

ALTERNATIVE WAY TO CREATE 

TRANSMISSION LINE AND FENCE  
This section presents an alternative way to create the fence and transmission line model that will 

introduce the user to some useful SESCAD tools. This procedure is to be used instead of the steps 2 

& 3 of section 3.1.2.1.Afterwards, to create profiles, the user can follow the instructions as before in 

step 5 of section 3.1.2.1. 

C.1 DATA ENTRY 

Create Object tool 

Lets start drawing the fence. First, from the Edit menu, select Create Object. The Create Object 

screen will appear. If you select Single Conductor, you can enter the starting and ending 

coordinates of a linear conductor such as a phase wire, a neutral wire or a fence pole.  Here, we will 

enter  the  coordinates  for  the  lower  conductor  of  the  fence:  start  (-80m,0m,-1m)  and  end 

(120m,0m,-1m). Note that, in SESCAD, the z coordinates is negative when the conductor is above 

the soil and positive when it is in the soil. Just click Close to come back to SESCAD  main window. 

In the same way, you can create the fence posts with the coordinates of conductors C12 and C13 

given in Table A.1. 

 

Draw Conductors tool 

For the upper conductor of the fence, which is 1m above the lower one, we can still use the same 

method or draw it directly by using the Draw Conductors tool  in the left-hand bar menu. With 

the mouse, drag the cross over the top of a fence post and click. Do the same over the second fence 

post. As you may have noticed, the nodes of the new conductor clips automatically on the fence's 

ones so that the coordinates of the upper fence conductor don't need to be entered manually.  
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Path Operation tool 

Now, to create the phase wires, we will use another tool called 

"Path Operation". First, we need to draw the phase wire which is 

in the middle i.e. phase B (see Figure 2.1(a)). Its coordinates, 

given by C2 in Table C.1, can be entered the same way as before. 

Once created, click on it and go to  Tools>Path Operations... in 

the menu. The following window should appear. Select 

"Conductors" in the Create Object  drop-down menu.  Then, adjust  

the depth  to -20m and the shift distance to 10m. Finally, uncheck 

"Do Not Shift" and press OK. As you can see, you just created the 

phase wires A and C from shifted copies of  phase B. 

Display and Zoom 

To see all objects, click on  on the left vertical task bar or 

select Display>Zoom to All Objects in the menu. You can 

change the 3D view by selecting  in the vertical bar. If you 

drag the mouse while holding the mouse left button, you will 

displace the drawing. If you do the same and hold the Shift Key, 

you will rotate the drawing around an axis perpendicular to the screen. If, instead, you hold the Ctrl 

Key, you will change the 3D perspective view. As an alternative, you can also use the XY, XZ and 

YZ  buttons in the horizontal bar for a fast display of the plan views. In any time, you can Zoom in 

or out with the mouse wheel. 

Conductors Characteristics 

Now, we will define the characteristics of each conductor. First, select 

a conductor with the mouse, then right-click and select 

Characteristics. A screen like the following one will appear: 

Here, the characteristics for phase A conductor appeared since we 

chose to click on this conductor for our exemple. As it can be seen, a 

radius of 0.0191m was assigned to the conductor since it is the typical 

radius of a 1565 kcmil 36/7 ACSR conductor (see description in 

section 2-1). 

The Conductor Type for  phase A has been  defined as 1- Aluminium. 

To take a look to the properties assigned to this conductor type, just 

click on the ... tab button beside the Conductor Type drop-down 

menu. The table of properties for all conductor types will appear. 

Looking at the whole table, we see that Conductor type No. 1 is 

defined as aluminum (1565 kcmil 36/7 ACSR). Aluminiun is an arbitrary name entered at the end of 

the first row for the identification of a type of conductor properties. Usually, the name is chosen in a 

way that describes the conductor-type (ACSR, alumoweld, phaseA, gaspipe1,...). The different 

physical properties can then be assigned accordingly; in our exemple, we needed to specify only the 

Uncheck 
Uncheck box 

Select 

"Conductors" 
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relative resistivity, the relative permeability and the inner radius of conductors. Exactly defined in 

the same way, Conductor Type No. 2 is the fence's steel tube with inner radius of 1 cm. As concern 

Conductor Type No. 0, it is SES default conductor-type i.e. pure copper unless it has been redefined. 

The Conductor Type No. -1 assigned as "Plastic" is another SES predefined conductor-type and it 

stands for a perfect insulating material. 

By going back to the Characteristics window, we can select in the same way a coating and an 

energization type. The Coating Type 0 means that the first coating type is selected, i.e. no coating. 

Similarly, Bus Number 0 means this conductor is not a source since Bus No. 0 has no energization.  

 

Still in the Characteristics window above, we have to set the Subdivision option to some adequate 

number which will control the ultimate number of segments in a conductor. This is especially useful 

when one needs to know the earth leakage current or the potential drop along a very long conductor 

segment. Usually, there is no need to specify any segmentation option for neutral wires because the 

conductor is automatically segmented at intersection with other conductors (such as poles, guy wire, 

etc.). However, if long segments are present in conductors such as cables, pipelines, railroads (etc.), 

it may become essential to specify a reasonable number of segments or a reasonable maximum 

length for the subdivision option.
5
 Here, the Number of Segments for Phase A remains at 1 since 

                                                 

5
 Node Subdivision option in HIFREQ subdivide conductors where they intersect each other while Presubdivide option in HIFREQ subdivides the 

conductors according to the individual subdivision  specified through SESCAD or Windows Input Toolbox. By default, both Presubdivide and Node 

Subdivision are selected. Thus, HIFREQ first subdivides all conductors at the crossing nodes, which is a good choice as long as node subdivision does 

not result in the generation of an excessive number of segments. Then HIFREQ continues to subdivide the largest segments until the specified 

individual subdivision number is reached. 
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we have no intention to look at the potential drop along the phase conductors in this example and the 

leakage is not an issue because the phase is overhead. 

Finally, as a general helful remark, note that the characteristics of each conducteur inside a group 

can be assigned in a single step with the same previous method. For example, since the conductors in 

the fence need to have the same characteristics, we can select all of them before assigning properties. 

A quick look to the characteristics window of the fence in the demo file would show that the fence 

condutors are 2 cm coated steel tubes with inner radius of 1 cm. 

Energization 

We now need to energize the phase conductors. There are two ways to model the energization of the 

transmission line: one using VOLTAGE energization, and the other a combination of LEAD and 

GPR energizations. When the phase voltages with respect to ground are constant or can be assumed 

to be relatively constant along the portions of the transmission line being modelled (as is the case 

here), the most convenient way to energize the network is to use the LEAD and GPR combination. 

However, the VOLTAGE energization combined with the inclusion of an appropriate load is the 

most accurate model since it will correctly show the phase potential variations along the 

transmission line length. The use of the VOLTAGE energization will be described hereafter. The 

energization of Lead and GPR will first be illustrated just below. 

As shown in Figure 2.1(a), each Phase conductors A, B and C carries 430 A and is maintained at a 

potential of 303.109 kV with respect to ground. The phase angle of the current and potential  is -120, 

0 and +120 degrees respectively. These six LEAD and GPR energizations can be defined in a table 

by clicking on Define> Energization Types. As can be seen in the following screen, the magnitudes 

and angles of currents and GPRs can be entered in different fields. For exemple, Bus No. 1 is phase 

A GPR energization with potential 303109e
j0

 Volts and Bus No. 4 is phase A LEAD energization 

with current 430e
-j120

 A. Once the data is entered, click OK to return to the SESCAD main screen. 

 

Now, these bus definitions have to be attributed to bus conductors that will feed the phase wires. We 

need to create those bus by drawing a small conductor segment (< 0.5m)_ at the beginning and end 

of each phase conductor (see the figure below). Alternatively, one can also cuts small segments at 

both ends of each phase. If you wish to do so, click the Power Tool in the vertical left pane and 

choose Break in the drop-down menu. With the mouse, click about 0.5m away from the end; repeat 

for all ends. Once done, click Select Objets  and select one of the new segments. Then, right-click 

and choose  Characteristics: the bus segment has the same properties as the phase and we only need 
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to assign a bus energization. Click on the Energization drop-down menu to select the appropriate 

energization. As a reminder, you can look in the table where all energizations were defined by 

simply clicking on the ... tab beside the drop-down menu. 

 

Once every bus segment is properly assigned, we have to check if the currents (leads) are flowing 

into the wires by looking at the segments orientations. To do so, go to View>Orientation and select 

Show Orientation of Conductors. If the conductor orientations of the lead busses are not  towards 

the phase wires, then they must be inverted
6
. First, select Power Tool > Flip  in the vertical menu; 

then click on every bus segment that need to be inverted. 

The same thing must be done with the GPR segments if the ground potential rises are in the wrong 

directions i.e. if they point away from the phase wires. Indeed, the pseudo-nodes
7
 must correspond to 

                                                 

6
 If the energization's ending point is not connected to any conductor, then the program will forces the current to be zero 

at this end. The result would be that the entire current would have to leak outside this tiny energization segment 

generating huge potentials and electric fields. 

7
 A pseudo-node is a conductor's end not connected to anything while a node is a conductor's end intersecting another 

conductor.  

Click here for 

Power Tool
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the remote ground potential (0 volt) in order to have the phase wires elevated at the right potential
8
. 

When this is done, you can go back to Show Orientation of Conductors  to remove the checkmark. 

As discussed above, voltage energizations can also be used to energize the transmission line. The 

VOLTAGE energization allows for more realistic modeling at the expense of a little bit more work 

since one must estimates the load impedances to get the correct currents. In this case, we need a 

VOLTAGE energization segment for each phase. At the other end of the phase wire, an impedance 

(typically a resistor) must be attached to each phase to limit the current flow. A resistance of 704.9 W 

(which is much larger than the impedance of the wires) will give a current of 430 A as before. If you 

wish to take a look to this energization method, a Windows Toolbox input file HI_01B.F05 is 

available in your CDEGS directory. As usual, this file can be imported using Import/Load in the 

CDEGS main HIFREQ screen or you can drag it into SESCAD to open it. 

 

                                                 

8
 At the same time, the GPR segment will absorb all the current flowing in the phase wires since currents cannot be 

allowed to leak into the air from the end of a conductor. 
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